ArcGlIS Server: publishing geospatial data to
the web using the EEA infrastructure

*IMPORTANT: Map Services should be published using the EEA Map Services Tick Sheet
for guidance. Contact Sebastien Petit (Sebastien.Petit@eea.europa.eu) to receive the tick
sheet if you don’t have it. Each time a Map Service is published a filled tick sheet should
be emailed to him.

Introduction

ArcGIS server is used to host advanced geospatial web services (Examples include the Natura 2000
viewer, Corine Land Cover) as well as more data heavy map services and datasets.

Partners operating outside of the agency can publish remotely to the servers if they have a desktop
version of ArcMap (Version 10.1 or higher).

To keep this guide simple we will focus on the publication of map-services. Feature services and Image
tiling services can also be produced in the same way. For extended information about ArcGIS Server
please visit http://server.arcgis.com/en/server/ or contact someone at IDM3.

IMPORTANT: when to use ArcGlIS Server to publish geospatial data

You can always use ArcGlIS Server to publish your data to the web. ArcGlIS server provides a powerful,
developer orientated platform to host advanced geospatial applications. But in case your dataset is
small and you need to quickly share it, it might be worth doing so in ArcGIS Online.

ArcGIS online is a great place to host and share web maps, feature services and small datasets. To
quickly upload and share small datasets please refer to the ArcGIS Online: publishing geospatial data
to the web using the EEA infrastructure document.

To be able to upload to the EEA, first you need to be given access rights. To gain access rights you should
email your EEA project manager and CC Sebastien Petit (Sebastien.Petit@eea.europa.eu) stating your
Eionet account, EEADMZ1 or EEA account username, to gain access rights

ArcGIS Server Publishing map-services

Publishing map-services is simple in the latest version of Arc Map. The EEA has a number of guidelines
to follow. Out of experience we learned that we should scale down to what we support.

Guideline 1: Data Types
The EEA requires that you prepare your data initially into File Geodatabase format for vector data, or
TIFF data for raster data. To convert a shapefile (vector) into a File Geodatabase feature class is a simple
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matter. First in ArcMap or Arc Catalog, use the catalog tree to navigate to your workspace. Then right
click > new > file geodatabase.
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You should rename the file Geodatabase, and then you can export your shapefile to the file
geodatabase by right-clicking on the shapefile in your map document table of contents > Data > Export
Data > Locate your file geodatabase and export.
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To convert raster data from other formats to TIFF, the idea is the same. Right click on the data layer in
the table of contents, export. You can then select the export folder and change the format to TIFF. It is



important that you follow this data rule as it is enforced to keep the EEA services running optimally. All
other formats will be systematically removed by our GIS administrator.

Guideline 2: Map Document:

We also require the data to be saved in an ‘.‘mxd’ map document that structures and represents the
data properly. It is best if you structure your folders so that the project folder (root) has subfolders —
Data — for the source data, Map — for the mxd map document and Doc — containing any readme
information
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Map documents can have many structures but we advise you to follow these guidelines.

1) Re-project your content into Web Mercator (WGS_1984 Web_Mercator_Auxiliary_Sphere)
projection. Most API’s Google, ArcGIS, Bing use this projection. The map may look wrong if you do not
do this. It will improve the performance drastically.

2)  Give your layers clear names. The web services need to be understood easily.

3)  Group what belongs together. For example if you need to layout on different scales make sure
those layers are grouped together.
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4) Scale dependencies should always be the last grouping. Make it possible to show the layer at all
scales by inlcuding extra layers that are default turned off.



5)  Groups turned off should show something when turned on. Meaning that some or all of the
underlaying layers should be turned on.

6) Make field names readable by giving aliases. For example you may want to create an alias for a
field called ‘c_code’ to ‘Country Code’ to make it more easily understandable
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In ArcMap right click on the layer and use properties. Go
to the Fields tab and type an alias for every field to make
it readable.

7)  Turn off those fields not relevant to the map service.

IMPORTANT: if your web services needs to be queried and return the geometry, the SHAPE field
should not be unchecked from the list.

8)  For code lists use “domains” to give proper naming.
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In ArcCatalog right click on the database and select properties. Add
the domains as lookup tables. (Make sure you use the same field
type)

9) Remove any base map or background information not part of the map content. Map services are
merged together into a web map at a later stage. A Base map is added from ArcGIS online.



10) If you have tables with data in them that you want to include, also drag them into the mxd.

Guideline 3: Metadata
Once your map is tested and functional you are ready to write metadata.

In order to achieve environmental protection goals, in the long-term and broad-scale, huge amount of
data is needed to be retrieved, stored and analysed.

Metadata contains information needed to understand, manage and effectively use this data.
So it is very important to write the metadata of the map you are going to publish.

In order to reuse your map users will need, at least, to know who created the map, when was it created
and the purpose.

Please follow reading in order to achieve this simple objective while publishing map services at the EEA
infrastructure.

1) Please check that your MXD data frame has an appropriate name and it’s not set to the default
value, “Layers”. Also the description of the map will be shown in the Rest ArcGIS Services.

Like in the picture below, right click in the data frame, located as the heading of the Table Of Contents in
ArcMap.
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2) Please check that each of the datasets included in your map already contains comprehensive

metadata.

To find out if a particular layer has metadata, you can search the source layer in ArcCatalog, right click
the layer and display the item information. In Europe, geographic stored data layers should be
documented with INSPIRE compliant metadata, although there are other formats (ARCGIS, 1ISO19139

standard, American FGDC).
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3) Create metadata for your ArcGIS map service by filling the appropriate fields of the MXD metadata

If you fill in the metadata fields for your map project (mxd) these then will be published within your map

service.

There are several formats to store metadata. For map services, none of them are required (they have
been designed for data sources), but to harmonize metadata procedures, it will be helpful to use the
most common metadata fields and use the INSPIRE version inside ArcCatalog by going into “Customize”-
>”ArcCatalog Options”. Select “Metadata” and in the Metadata Style select “INSPIRE Metadata

Directive”.
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Then right click the MXD file in the ArcCatalog window within ArcMap and select Item Description.

Once the window pops up, please click Edit to proceed (notice you have options to export and import
metadata for similar services, which can be helpful too if you have similar services).

There are many fields and not all are mandatory. The minimum we ask is for you to fill in the “Item
Description”, which include Title, Tags, Summary, Description and Credits, “Topic & Keywords” and
“Metadata Contacts”.
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When clicking in any of the fields it might be of aid to notice that there is a description or a small text in
the bottom of the editing window to help you filling in the information.

Guideline 4: Publishing

The agency wants to roll out its publishing plan in a series of gradual steps so that we can safeguard our
data, services and servers. To this this initially the EEA requires users to publish everything to the test
environment. Datasets will then be moved by our administrators into our production environment



Registering an ArcGIS server using the EEA’s infrastructure
You will need an EIONET account with publishing privileges to gain access to this.

1) In ArcCatalog go under “GIS Servers” and press “Add ArcGIS Server”

LA Connection to sdeproject_sa
= B3 GIS Servers

A Add ArcGIS Server

L Add ArcIMS Server

% Add WCS Server
Add WS Server
Add WMTS Server
arcgis on cow.eea.dmzl (admin)
arcgis on cow.eea.dmzl (publisher)
w7 arcgis on discomap.eea.eurcpa.eu
%7 arcgis on stage.discomap.eea.europa

=

L

B

+

2)  Select Publish GIS Services and press Next
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create a connection to use, publish, or administer
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3) Type the server Url and your credentials — this will be to the test environment such as

http://test.discomap.eea.europa.eu/arcgis

4)  Enter the Server Url, and make sure that ‘User ArcGIS Desktops Staging Folder’ is selected. Enter
your Eionet credentials and Press Finish. At this moment you should have EEA server registered to your
ArcCatalog.

5) Double click to see if you can access the content. You should see something like this.


http://test.discomap.eea.europa.eu/arcgis

Server URL: http: f/stage. discomap.eea.europa. eu/arcgis

ArcGIS Server: http:/fmyserver:6080/arcgis
Spatial Data Server: http: /fmyserver:8080 arcgis

Server Type:

Staging Folder: C:\Users'bliki\AppData'Local TemparcEEE 3\Staging @

Use ArcGIS Desktop's staging folder
Authentication

User Name: Bliki

Password: LLL LA
Save Username/Password

About ArcGIS Server connections
About Spatial Data Server connections

Publish your map to EEA’s infrastructure.

Open the map you created and follow the following steps.

1) In ArcMap go to “File” > “Share As” -> “Services”
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2)  Select “Publish as a Service” and press “Next”
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3) Select the server to publish the content towards (the test server you just added), create a service
name and press “Next”. Make the service name easily understandable

4) Select the agreed folder you can publish under and press “Next”.
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TIP: You might want to import the settings of other similar service already published. Click the Import
button at the top of the window (see image above). This will affect capabilities, item description and
other properties of the service. Be sure to change relevant properties or description before clicking the
publish button!

5) Go to Capabilities and check “WMS” and “WFS” if applicable.
6) Check the “Item Description” and check if all content is filled.

7)  Press the “Analyse” button. It will list you a number of issues if you have issues. Most of the time a
“Data source is not registered” would be shown. This is normal as we expect you to upload the data to
the server. (In large data cases, please contact EEA)

8)  Press the Publish button and you service will be packaged and uploaded to EEA’s infrastructure.

You map has new been published and can now be used inside ArcGIS online. Check your service using
the published URL for example http://test.discomap.eea.europa.eu/arcgis/rest/services. Follow EEA on
Facebook or Twitter or through Discomap for updates.
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